
Тема 3 Створення  та  оформлення  креслень. 

 

Лекція 1. Створення  та  оформлення  креслень 

План. 

1. Створення нового креслення. 

2. Оформлення креслення. 

3. Використання бібліотек деталей. 

1) Створення нового креслення. 

 Створення нового креслення відбувається при завантаженні програми AutoCAD коли 

з’являється майстер здійснення налаштувань в кресленні. За допомогою цього майстра можна 

змінити такі параметри, як напрям відображення кутів, кількість цифр після коми у відображенні 

розмірів, розміри листа на якому буде виконуватись креслення. 

2) Оформлення нового креслення. 

 Креслення оформлюється згідно до стандартів. Рамка навколо креслення повинна бути на 

відстані 20 мм від правого краю, 15 мм від нижнього і 5 мм від верхнього і лівого країв. Відстань 

15 мм від нижнього краю зумовлена неможливістю віддрукувати лінію на меншій відстані для 

струменевих принтерів. 
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3) Використання бібліотек деталей. 

Часто в кресленні доводиться багато разів використовувати одну й ту саму групу об’єктів. 

Наприклад, на плані поверху повторно розміщати умовне позначення однакових дверей, вікон, 

сантехнічних приладів тощо. Для спрощення такої роботи в AutoCAD існують блоки. В 

загальному випадку блок являє собою набір об’єктів, які зберігаються під певним іменем, і при 

потребі вставляються в креслення. Проте AutoCAD обробляє блок як один об’єкт, незалежно від 

кількості використаних для його створення елементів, тому його легко копіювати, переміщати, 

масштабувати та повертати. При потребі блок можна розчленувати на окремі складові об’єкти. 

З блоком можна працювати так само як і з будь-яким іншим об’єктом креслення. Можна 

використовувати прив’язку до характерних точок окремих об’єктів блока. Разом з тим, AutoCAD 

оперує блоком як одним цілим об’єктом. 

Програма AutoCAD дозволяє приєднувати до блока текстову інформацію, яка називається 

його атрибутом. В основному атрибути використовуються для маркування об’єктів на кресленні 

та для створення простих баз даних і специфікацій. 

Використання блоків в AutoCAD дозволяє: 

·                    створити бібліотеки вузлів та деталей, а також типових елементів креслення, які можна 

використовувати повторно; 

·                    зменшити розмір файла та прискорити обробку складних креслень за рахунок того, що 

сам блок зберігається тільки один раз, а екземпляри блока представляються в базі даних креслення 

як посилання на нього; 

·                    забезпечити швидке створення та редагування креслення вставляючи в нього 

заздалегідь розроблені елементи, змінюючи окремі вузли шляхом перевизначення блоків, 

переміщаючи та копіюючи блоки замість наборів окремих геометричних об’єктів; 

·                    зв’язати з графічними елементами креслення текстовий опис – атрибут блока, який 

можна змінювати при вставці блока в креслення. 

 Cтворення блоків 

Перед створенням блока, потрібно побудувати його складові об’єкти та призначити їм 

необхідні властивості. Серед цих об’єктів можуть бути й інші (вкладені) блоки. Після створення 

об’єктів виконати наступну послідовність операцій. 

Запустити команду Block одним із способів: 

–  командна стрічка:  Block (блок); 

–  інструментальна панель “Draw” (Рисование), піктограма “Make Block” (Создать блок):  

; 

–  меню: Draw > Block > Make… (Рисование > Блок > Создать…). 

Після запуску команди відкривається діалогове вікно “Block Definition” (Описание блока) 

(рис. 1), елементи управління якого дозволяють задати усі необхідні параметри блока та зберегти 

його в базі даних креслення. 



 
Рис. 1. Діалогове вікно “Block Definition” та послідовність задання параметрів у ньому 

  

Послідовність задання параметрів блока показана на рис.1: 

1.  В текстовому полі Name (Имя) ввести ім’я блока. Довжина імені не повинна перевищувати 

255 символів. Дозволяється використовувати пробіли. Не дозволяється використовувати наступні 

символи:  < > / \ “ : ? * | , = ‘  

2. Клацнути на кнопці Select objects (Выбрать объекты). Після цього AutoCAD тимчасово 

закриє діалогове вікно та запропонує виділити об’єкти, які будуть утворювати блок. Виділяти 

об’єкти можна будь-яким способом. Щоб завершити виділення та повернутись до діалогового 

вікна потрібно клацнути правою кнопкою мишки або натиснути клавішу <Enter>. Якщо об’єкти 

були виділені перед запуском команди Block, тоді цю операцію можна пропустити оскільки 

діалогове вікно вже буде містити інформацію про виділені об’єкти. 

3. Клацнути на кнопці Pick point (Указать точку) та вказати графічним курсором базову точку 

вставки блока. Якщо координати базової точки не вказувати, тоді вона прийме значення за 

замовчуванням:  х=0, у=0, z=0, проте таке її  положення в переважній більшості випадків є 

невдалим. Щоб забезпечити точність при вказуванні базової точки слід завжди використовувати 

об’єктну прив’язку. 

4.  Вказати, що потрібно зробити з об’єктами після створення блока: 

-                     Retain (Оставить) – залишити об’єкти в кресленні (створений блок не вставляється в 

креслення, а лише зберігається в його базі даних); 

-                     Convert to block (Преобразовать в блок) – перетворити об’єкти в блок (створений блок 

вставляється в креслення, і зберігається в його базі даних); 

-                     Delete (Удалить) – знищити об’єкти з креслення (створений блок не вставляється в 

креслення, а лише зберігається в його базі даних). 

5. Вибрати режим Create icon from block geometry (Создать образец по объектам блока) для 

того, щоб AutoCAD створив піктограму попереднього перегляду блока у палітрі “Design Center” 

(Дизайн-центр). Піктограми попереднього перегляду полегшують роботу з бібліотеками блоків. 

Якщо вибрати режим Do not include an icon (Не включать пиктограмму), тоді піктограма 

попереднього перегляду створюватись не буде. 

6. В списку Drag-and-drop units (Единицы для вставки) вибрати одиниці вимірювання, які 

планується використовувати при вставці блока в креслення. Якщо одиниці вимірювання не мають 

значення, тоді вибрати варіант Unitless (Безразмерные). 

7. В полі Description (Пояснение) можна ввести текстове пояснення до створеного блока. Воно 

відображається у палітрі “Design Center” (Дизайн-центр), і полегшує роботу з бібліотеками блоків. 

8.  Клацнути на кнопці ОК. 

Створений таким чином блок зберігається в базі даних поточного креслення. 

  



Приклад.  Створити блок, який представляє умовне позначення ванни. 

Побудувати об’єкти, з яких буде складатись майбутній блок (рис. 2) в шарі з ім’ям “0”, та 

призначити усім елементам властивості By Layer (По слою). 

 
Рис. 2. Побудовані об’єкти, з яких буде складатись блок 

  

Запустити команду Block (рис. 3). 

 
Рис. 3. Послідовність введення параметрів у вікні “Block Definition” 

  

Далі в діалоговому вікні (рис. 3) задати параметри в наступній послідовності: 

1. Ввести ім’я блока “Ванна1500х750”. Назва лаконічна та дає уявлення про розмір умовного 

позначення ванни. 

2. Потрібно вибрати об’єкти, з яких складатиметься блок. Для цього клацнути на кнопці Select 

objects (Выбрать объекты). Діалогове вікно тимчасово закриється, і AutoCAD запропонує 

курсором у формі прицілу виділити об’єкти. Щоб завершити вибір потрібно клацнути правою 

кнопкою мишки, після чого діалогове вікно відкриється знову. 

3. Потрібно вказати положення базової точки блока. Для цього клацнути на кнопці Pick point 

(Указать точку). Діалогове вікно тимчасово закриється, і AutoCAD запропонує курсором у формі 

перехрестя вказати точку. Для умовного позначення ванни її доцільно вибрати в одному з кутів 

габаритного прямокутника. Клацнувши в базовій точці, діалогове вікно знову відкриється. 

4. Вибрати опцію Convert to block (Преобразовать в блок) для того, щоб набір початкових 

об’єктів AutoCAD замінив блоком. 

5. Вибрати опцію Create icon from block geometry (Создать образец по объектам блока) для 

того, щоб AutoCAD створив піктограму попереднього перегляду блока. Наявність піктограми 

полегшує пошук потрібних блоків у вікні палітри дизайн-центру. 

6. В списку Drag-and-drop units (Единицы для вставки) залишити значення одиниць 

вимірювання  Millimeters. 



7. В полі Description (Пояснение) ввести до блока текстовий коментар “Умовне позначення 

ванни 1500х750. М1:100”. Цей текст буде відображатись у віконечку „Опис” палітри дизайн-

центру. Це допоможе при пошуку потрібного блока серед подібних. 

8.  Завершити створення блока, клацнувши на кнопці ОК. 

В результаті блок з іменем “Ванна1500х750” буде збережено в базі даних креслення, і на місці 

початкових об’єктів програма розмістить його екземпляр. Створений таким чином блок можна 

використовувати в поточному файлі креслення. Використовуючи палітру дизайн-центру цей блок 

можна використовувати і в інших файлах. 

  

Збереження блока як файлу 

За допомогою палітри дизайн-центра можна вставляти в креслення блоки безпосередньо з 

іншого як відкритого, так і закритого в даний момент креслення. Проте багато користувачів 

надають перевагу організації бібліотеки блоків у вигляді окремих файлів. Така форма збереження 

блоків іноді полегшує пошук та вибір потрібного матеріалу. 

Після створення об’єктів виконати наступну послідовність операцій. 

Запустити, використовуючи командну стрічку, команду Wblock . 

Далі відкриється діалогове вікно “Write Block” (Запись блока) (рис. 4), елементи управління 

якого дозволяють задати усі необхідні параметри блока та зберегти його у вигляді окремого файлу 

на диску. 

 
Рис. 4. Діалогове вікно “Write Block” та послідовність задання параметрів у ньому 

  

Послідовність задання параметрів для збереження блока у вигляді файла показана на рис. 4: 

1.  В групі Source (Источник) вибрати спосіб створення нового файла: 

- Block (Блок) – якщо блок в кресленні вже був створений раніше, і тепер залишається 

зберегти його у вигляді окремого файла. У списку розміщеному поруч вибрати ім’я потрібного 

блока. 

- Entire drawing (Весь чертеж) – якщо у вигляді блока на диску потрібно зберегти все 

креслення. 

- Objects (Объекты) – якщо для збереження на диску потрібно створити новий блок. В цьому 

випадку стануть доступними елементи управління необхідні для виділення об’єктів та задання 

базової точки. 

2. Клацнути на кнопці Select objects (Выбрать объекты). Після цього AutoCAD тимчасово 

закриє діалогове вікно та запропонує виділити об’єкти, які будуть утворювати блок. Щоб 

завершити виділення та повернутись до діалогового вікна потрібно клацнути правою кнопкою 

мишки або натиснути клавішу <Enter>. Якщо об’єкти були виділені перед запуском команди 

Wblock, тоді цю операцію можна пропустити, оскільки діалогове вікно вже буде містити 

інформацію про виділені об’єкти. 



3. Клацнути на кнопці Pick point (Указать точку) та вказати графічним курсором базову точку 

вставки блока. Якщо координати базової точки не вказувати, тоді вона прийме значення за 

замовчуванням:  х=0,  у=0,  z=0, проте таке її положення в переважній більшості випадків невдале. 

Щоб забезпечити точність при вказуванні базової точки слід завжди використовувати об’єктну 

прив’язку. 

4. Вказати, що потрібно зробити з об’єктами після створення блока. Зміст цих опцій 

аналогічний опціям в діалоговому вікні “Block Definition” (Описание блока) (рис. 1). 

5. В полі File name and path (Имя файла и расположение) ввести ім’я та шлях збереження 

файла. Клацнувши на кнопці з трьома крапками, відкриється діалогове вікно Browse for Drawing 

File (Обзор для файла чертежа). З його допомогою знайти потрібну папку для збереження файла 

блока, ввести його ім’я та клацнути на кнопці Save (Сохранить) щоб повернутись у вікно “Write 

Block” (Запись блока). Якщо блок вже створений у кресленні, то під час запису його на диск як 

ім’я файла рекомендується використовувати ім’я блока. Це дозволить в подальшому, при вставці 

блоків у креслення, уникнути плутанини з назвами. 

6. В списку Insert units (Единицы для вставки) вибрати одиниці вимірювання, які планується 

використовувати при вставці блока в креслення. Якщо одиниці вимірювання не мають значення, 

тоді вибрати варіант Unitless (Безразмерные). 

7.  Задавши необхідні параметри, клацнути на кнопці ОК. 

Створений таким чином блок буде записаний на диску у вигляді окремого файлу. 

  

Вставка блоків у креслення 

Щоб вставити блок, який зберігається в поточному кресленні, використовується команда 

Insert (Вставить). Цією ж командою можна вставляти в креслення блоки, збережені у вигляді 

окремих файлів, або будь-які інші файли креслень в форматі  *.dwg. 

Блоки в креслення можна також вставляти за допомогою палітри “Design Center” (Дизайн-

центр).  

  

Використання команди Insert 
Запустити команду Insert одним із способів: 

–  командна стрічка:  Insert (вставка); 

–  інструментальна панель “Draw” (Рисование), піктограма “Insert Block” (Вставить блок):  

; 

–  меню: Insert > Block … (Вставка > Блок …). 

Відкриється однойменне діалогове вікно (рис. 5). 

 
Рис. 5.  Діалогове вікно “Insert” та послідовність задання параметрів у ньому 

  

Послідовність задання параметрів для вставки блока в креслення показана на рис. 5: 



1.  Вибрати блок збережений в поточному кресленні (використовуючи список Name (Имя)) 

або блок збережений у вигляді файлу на диску (використовуючи кнопку Browse (Обзор)). У 

списку Name (Имя) міститься перелік усіх блоків створених у даному кресленні або раніше 

вставлених у нього, а також імена деяких блоків, які AutoCAD створює автоматично під час 

виконання певних команд. 

2. В групі опцій Insertion point (Точка вставки) вибрати спосіб задання положення базової 

точки блока. Якщо відомі координати базової точки блока в кресленні, тоді потрібно зняти 

прапорець Specify On-screen (Задание параметров на экране) та у відповідних полях ввести 

координати Х, У та Z. Якщо ж координати положення базової точки блока в кресленні не відомі, 

тоді потрібно відмітити прапорцем опцію  Specify On-screen (Задание параметров на экране). В 

цьому випадку AutoCAD запропонує вказати її положення в кресленні графічним курсором. Цей 

варіант значення параметра використовується найчастіше, оскільки, як правило, відоме положення 

блока відносно інших об’єктів креслення. 

3. В групі опцій Scale (Масштаб) вибрати спосіб задання масштабу блока. Якщо масштаб 

потрібно вказати графічно в кресленні, тоді відмітити опцію Specify On-screen (Задание 

параметров на экране). Якщо ж відоме значення масштабних коефіцієнтів по осях Х, У та Z, тоді 

зняти прапорець Specify On-screen (Задание параметров на экране) та ввести числові значення у 

відповідні поля. Якщо по всіх осях масштабні коефіцієнти однакові, тоді відмітити опцію Uniform 

Scale (Равные масштабы) та ввести одне числове значення в полі масштабного коефіцієнта для осі 

Х. При введенні різних масштабних коефіцієнтів, блок буде розтягуватись по осі, для якої 

коефіцієнт k > 1, і стискатись по осі з коефіцієнтом 0 < k < 1. Якщо масштабний коефіцієнт 

від’ємний, тоді крім масштабування блок ще й дзеркально відобразиться в цьому напрямку 

(від’ємне значення коефіцієнта по осі Ох дзеркально відображає відносно осі Оу та навпаки). 

4. В групі опцій Rotation (Поворот) вибрати спосіб задання кута повороту для блока. Якщо 

числове значення кута відоме, тоді зняти прапорець Specify On-screen (Задание параметров на 

экране) та ввести величину кута в поле Angle (Угол). Якщо ж потрібно вказати кут повороту блока 

на полі креслення графічно, тоді слід відмітити опцію Specify On-screen (Задание параметров на 

экране). 

5. Клацнути на кнопці ОК, після чого діалогове вікно закриється, і, залежно від заданих в 

ньому параметрів, почнеться процедура розміщення блока в кресленні. Якщо прапорець Specify 

On-screen (Задание параметров на экране) встановлено хоча б в одній з груп параметрів, тоді 

AutoCAD у командній стрічці виведе запрошення вказати відповідні параметри вставки блока. 

Якщо відмітити опцію Explode (Расчленить), тоді після вставки блока в креслення він 

розчленовується (розбивається) на окремі складові об’єктів. Якщо до складу блока входили 

вкладені блоки, тоді їх доведеться розбивати окремо командою Eхplode (Расчленить). 

  

Використання палітри “Design Center” 

Палітру дизайн-центра зручно використовувати для вставки блока з іншого креслення 

(закритого чи відкритого в даний момент), тобто блока, не оформленого у вигляді окремого файла. 

Відкрити палітру дизайн-центра можна одним зі способів: 

–  інструментальна панель “Standard” (Стандартная), піктограма “Design Center” (Дизайн-

центр):   ; 

–  меню: Tools > Design Center   (Сервис > Дизайн-центр). 

Щоб вставити блок, який зберігається в базі даних іншого файла, потрібно в палітрі дизайн-

центра (рис. 6) виконати наступні дії: 

1.  Активізувати закладку Folders (Папки). 

2.  В лівій панелі, як в “Провіднику” Windows, знайти файл креслення, з якого потрібно 

імпортувати блок. Двічі клацнути на ньому або клацнути на значку “+” біля імені файла. Під 

назвою файла відкриється список його компонентів. Клацнути на групі Blocks (Блоки). Після 

цього, в правій панелі дизайн-центра відкриється список блоків, які зберігаються у знайденому 

файлі. 



 
Рис. 6.  Палітра “ Design Center” та послідовність вибору об’єктів для вставки блока з існуючого файла 

  

3.  В правій частині вікна виділити потрібний блок. Кнопка View (Вид) дозволяє змінювати 

вигляд списку блоків. Натиснута кнопка Preview (Просмотр) відкриває віконце попереднього 

перегляду блока. Натиснута кнопка Description (Описание) відкриває віконце з описом блока 

(якщо такий текст було введено під час його створення). Натиснута кнопка Tree View Toggle 

(Переключатель древовидной структуры) відкриває ліву панель дизайн-центра (панель навігації). 

Далі можливі два способи імпорту блока в креслення: 

– перший спосіб – двічі клацнути на піктограмі блока; AutoCAD відкриє діалогове вікно 

“Insert” (Вставка) (рис. 5), в якому потрібно задати необхідні параметри вставки; 

– другий спосіб – перетягнути піктограму блока в поле креслення; в цьому випадку AutoCAD 

вставить блок у тому місці, де буде відпущена кнопка мишки (масштаб та кут повороту будуть 

прийняті за замовчуванням). 

Палітра дизайн-центра (рис. 6) дозволяє вставляти в поточне креслення весь файл іншого 

креслення. Для цього потрібно у лівій частині палітри (в панелі навігації) виділити папку, в якій 

міститься необхідний файл. В правій частині палітри буде відображено вміст виділеної папки. 

Знайти там потрібний файл, клацнути на ньому правою кнопкою мишки та в контекстному меню 

(рис. 7) вибрати команду Insert as Block… (Вставить как блок…). AutoCAD відкриє діалогове 

вікно “Insert” (Вставка) (рис. 5), в якому потрібно задати необхідні параметри вставки. Вставлений 

таким чином файл поводить себе як блок, тобто усі його елементи обробляються як один об’єкт. 

При потребі цей блок можна розчленувати командою Explode. 

 
Рис. 7.  Контекстне меню вставки файла як блока у нове креслення 

  



За допомогою палітри дизайн-центра можна не тільки імпортувати блоки з інших креслень 

збережених на диску, але і вставляти їх з бази даних відкритого в даний момент креслення. Такий 

спосіб вставки, на відміну від команди Insert (Вставка), дозволяє використовувати усі переваги 

дизайн-центра, основною з яких є наочне представлення списку блоків за допомогою їхніх 

зображень попереднього перегляду. 

Щоб вставити в поточне креслення блок, який зберігається в базі даних відкритого в даний 

момент файла, потрібно в палітрі дизайн-центра (рис. 8) виконати наступні дії: 

1.  Активізувати закладку Open Drawings (Открытые чертежи). 

2.  В лівій панелі будуть представлені відкриті файли креслень. Двічі клацнути на файлі, з 

якого потрібно імпортувати блок, або клацнути на значку “+” біля його імені. Під назвою файла 

відкриється список його компонентів. Клацнути на групі Blocks (Блоки). Після цього, в правій 

панелі дизайн-центра відкриється список блоків, які зберігаються у виділеному файлі. 

3. В правій панелі вікна виділити потрібний блок, та вставити його в креслення або двічі 

клацнувши на піктограмі блока, або перетягнувши його за допомогою мишки. 

 
Рис. 8.  Палітра “Design Center” та послідовність вибору об’єктів для вставки блока з відкритого файла 

 


